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Welcome to LightWave 11.0!
NewTek is pleased to present a new edition of LightWave 3D, offering a range of new features and 
functions to enhance workflow for 3D content creators.  LightWave 11.0 offers a new Instancing 
workflow with a variety of distribution options, motion and surfacing controls; hardbody and 
softbody Bullet Dynamics; a new Flocking Controller for applying behaviors to masses of objects; 
Python scripting with access to the same range of SDK elements as LScript; new interchange tools 
for ZBrush and Unity; improved volumetrics; FiberFX performance improvements, texturing of 
fibers, support for the new instancing system, and a new volumetric mode that provides normals 
and improved support for buffer output; new blending capabilities for all modes of HyperVoxels; a 
new, more powerful and comprehensive Compositing Buffer Export image filter; enhancements to 
the Viewport Preview Renderer (VPR) and rendering speed improvements for GI and sampling; and 
performance enhancements in both Layout and Modeler.

Loads of additional performance and stability enhancements make 11.0 a must-have update for 
any LightWave user.

Recommended Instructions for Setting Up LightWave 11.0

Important Notes before installing
LightWave currently uses a USB hardware key to license the software. Proceed first with installing 
the software, then attach the USB hardware key before you run the software.

Do not install the Lightwave 11.0 software over your v10.x or earlier series software!

If you have been using a beta version of LightWave 11.0, please delete the configuration files 
related to those builds. After deleting these files, new configuration files will be created after 
opening Layout and/or Modeler.

License keys issued for LightWave during a beta program cycle (prior to the application going to 
what is called a Gold Master shipping status) are typically 90-day keys, which have to be renewed 
after that time period expires.

Installation

LightWave 3D has three platform installers, as follows:

•	 MacUB: This includes 32-bit and 64-bit applications for Intel Processors, all in a single 
application bundle. It is recommended you do not install to a path that includes spaces.

•	 Windows 32: Runs on all 64-bit x86 processors and on those more modern 32-bit processors 
that include the SSE2 instruction set.  Does not run on older 32-bit x86 processors that do 
not include the SSE2 instruction set.

Introduction
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•	 Windows 64: Runs on all 64-bit x86 processors and requires a 64-bit version Windows OS.

Installers are available by download.

1)	 Download the appropriate installer to your system and run it, or select 
and run the appropriate installer from the Program Install DVD.

2)	 Follow the simple step-by-step instructions the Installer 
will provide to complete your installation.

Windows Installer Note

Please note that the Windows Installers include the Sentinel Driver Installer.  If you use the option 
to install the Sentinel Driver during your LightWave install, please note that when the Sentinel 
Installer asks you to restart the system/restart later, choose restart later, and click finish on the 
Sentinel installer.  You will see an error message indicating that the Sentinel Installer has reported 
an error to the LightWave installer. You can ignore that message.

Registering and Licensing

Once you have installed LightWave 11.0, you can follow the registration instructions below to 
register your 11.0 upgrade.

1)	 You need the serial number from your LightWave package if you have 
purchased a new full seat of LightWave, or from your New Order Alert 
email if you purchased an upgrade online from NewTek.

2)	 Attach the USB hardware key.
3)	 Run Layout. When Layout is first run, it will report that the license.key file is not present 

and run in a limited “Discovery” mode. A small panel will display the Hardware Lock ID, 
usually a five-digit number. If you miss getting this noted when you start up Layout, you 
can go to the Help menu dropdown, click on it, and select About LightWave 3D.  The About 
box will display the HardWare Lock ID just below the main logo at the top of the box.

4)	 When you have the serial number and the lock ID both 
ready, open a browser window and enter:

http://reg.newtek.com/

5)	 This takes you to the NewTek online registration system.  If you have not registered 
a product with NewTek before, then Use the “New Registration” option on the page 
to create a new account with username and password. Be sure to put a valid email 
address into your account information, since your license key and other important 
information will be emailed to you. If you have already registered a product 
with NewTek, enter your username and password to enter your account.
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6)	 Once in your account, look for the Product Registration section on the page, use the “Select 
your Product” dropdown to select “LightWave 3D” to register a new full seat or an upgrade.

7)	 Next, you will get a page that has an entry field for the serial 
number. Type in your serial number, and hit enter.

8)	 Next you will be presented with a field to enter your Lock 
ID. Type in your Lock ID, and hit enter.

9)	 The system will now generate and display your license information, including 
the permanent license key, a 16-digit number, with a dash between 
each four-digit segment. Highlight and copy the license key.

10)	Go to Layout, and from the Help dropdown, select “Enter License”.
11)	Paste the key into the entry field, and click on “OK”.
12)	Close and then relaunch Layout. LightWave should now run in fully licensed mode.

If you experience any problems with the automated registration system, you can also obtain your 
license key by emailing your serial number and lock ID to reg@newtek.com. 

NewTek Customer Service will send a return email with your permanent LightWave 11 license key 
within 48 hours, during the normal work week.  Then use Steps 10 through 12 above to enter your 
license key in the product.

Documentation and Content Files: Install Disk and Download

Install Disk

The Install disk contains documentation as PDF files, and a content folder archive.  The content 
folder is in “zip” compression format, so it can easily be extracted on both Windows and Mac OSX 
platforms using the built-in compression utilities, or the utililty of your choice.

Download

The downloadable files for content and documentation are also zip files.  However, the main 
content library is a two-part archive.  For most zip utilities it is only necessary to select the first file, 
and the utility will extract both files.

On Windows, 7-zip (http://www.7-zip.org/download.html) worked well in this regard.

On Mac, MacHacha (http://homepage.mac.com/julifos/soft/machacha/index.html) is a Mac 
application that will join the split files into a single .zip file, which can then be double-clicked to 
open it in the built-in unzip tool in OSX.  This alternative makes it possible to avoid the Terminal 
altogether and just double-click the *.zip.001 file followed by double-clicking the resulting *.zip 
file.
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Additional alternatives for the Mac user can be found at the 7-zip site downloads page - under 
“Some unofficial p7zip packages for Linux and other systems:”

•	 p7zip for Mac OS X
•	 EZ 7z for Mac OS X
•	 7zX for Mac OS X

CNet:

MacHacha: http://download.cnet.com/MacHacha/3000-2250_4-35801.html
7zX for Mac OS X:  http://download.cnet.com/7zX/3000-2250_4-89405.html

An alternative using strictly built-in OSX features is to enter this in a Terminal window:

cat LightWave_11_0_Content.zip.001 LightWave_11_0_Content.zip.002 > LightWave_11_0_
Content.zip

Then, double-click the resulting file called “LightWave_11_0_Content.zip” to extract the files within.  
One could also enter “open LightWave_11_0_Content.zip” into the Terminal instead of double-
clicking on it.

Windows® Vista and Windows 7 Editions

Running without the Hub

Running in “Isolate” Mode

Creating Custom Config Files

One of the important changes is to the communications between the applications. LightWave uses 
a module called the “Hub” to provide communications and data exchange between Layout and 
Modeler. A means for not running the Hub has always been an option for workflows where this 
exchange is not desired. To provide for a means of interoperation of Layout and Modeler with other 
applications, operations have been changed so that a new interprocess communications mode will 
be active when the Hub is not active. When this new interprocess communication is active, Layout 
and Modeler will each update an object that they both have loaded, and which has been changed 
and saved from one of the applications. Operation with no communications is now accommodated 
with a new “Isolate” Mode.

For full discussions of these new modes and features, please see the manuals or help files.

For your convenience, we provide information below about how to run without the Hub, how to 
run in Isolate mode, and how to redirect your config files for portability of your LightWave folder, if 
you will be running from an external drive and changing systems.
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The easiest means to run without the Hub is to locate and rename the Hub executable file in the 
bin folder of your LightWave 11 installation. Once renamed, Layout and Modeler will not be able to 
locate and use it.

For those times when you do not want the applications to crosstalk at all, there is now and “Isolate” 
mode, which both runs Layout and Modeler without the Hub, and turns off the new interprocess 
communication. To run in the new “Isolate” mode you will need to set up desktop shortcuts.

You can use the following steps to make Desktop shortcuts to run Layout and Modeler without the 
Hub:

1)	 Locate the folder where you copied the LightWave 11 software.
2)	 Open the bin Folder
3)	 Find the Layout.exe file.
4)	 Right-click and choose Create Shortcut
5)	 Right-click on the new shortcut and choose Properties
6)	 For Target, go to the end of the path and type -0
7)	 The entry should look something like this:

C:\Program Files\NewTek\LightWave11.0\bin\Layout.exe -0

8)	 Repeat steps 3-7 for Modeler.exe
9)	 Use the shortcuts you created each time you open the software.

You can use the following steps to make Desktop shortcuts to run Layout and Modeler in Isolate 
mode (Hub also does not run):

1)	 Locate the folder where you copied the LightWave 11 software.
2)	 Open the bin Folder
3)	 Find the Layout.exe file.
4)	 Right-click and choose Create Shortcut
5)	 Right-click on the new shortcut and choose Properties
6)	 For Target, go to the end of the path and type -i
7)	 The entry should look something like this:

C:\Program Files\NewTek\LightWave11.0\bin\Layout.exe -i

8)	 Repeat steps 3-7 for Modeler.exe
9)	 Use the shortcuts you created each time you open the software.
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Desktop Shortcuts to Redirect the Config Files
1)	 For Windows systems, enter the [username]\LightWave folder created by LightWave.
2)	 Create a new folder named “Configs”.
3)	 Open the Configs folder and copy the path.
4)	 Navigate to the folder where LightWave 11 is installed, and enter the bin folder.
5)	 Find the Layout.exe file.
6)	 Right-click and choose Create Shortcut
7)	 Right-click on the new shortcut and choose Properties
8)	 For Target, go to the end of the path and type -c
9)	 Paste the Configs path to the end of -c. If you have any spaces in the 

Config path, put the path in quotation marks. The path should look 
something like this (your exact path may be different):

C:\Program Files\NewTek\LightWave11.0\bin\Layout.exe -c”C:\Program Files\NewTek\
LightWave11.0\support\Configs”

10)	 Repeat steps 5-9 for Modeler.exe
11)	 Use the shortcuts you created each time you open the software.

Desktop Shortcuts to run without the Hub, and to Redirect the Config Files
1)	 For Windows systems, enter the [username]\LightWave folder created by LightWave.
2)	 Create a new folder named “Configs”.
3)	 Open the Configs folder and copy the path.
4)	 Navigate to the folder where LightWave 11 is installed, and enter the bin folder.
5)	 Find the Layout.exe file.
6)	 Right-click and choose Create Shortcut
7)	 Right-click on the new shortcut and choose Properties
8)	 For Target, go to the end of the path and type -0 -c
9)	 Paste the Configs path to the end of -c. If you have any spaces in the 

Config path, put the path in quotation marks. The path should look 
something like this (your exact path may be different):

C:\Program Files\NewTek\LightWave11.0\bin\Layout.exe -0 -c”C:\Program Files\NewTek\
LightWave11.0\support\Configs”

10)	Repeat steps 5-9 for Modeler.exe
11)	Use the shortcuts you created each time you open the software.
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Desktop Shortcuts to run in Isolate Mode,  and to Redirect the Config Files
1)	 For Windows systems, enter the [username]\LightWave folder created by LightWave.
2)	 Create a new folder named “Configs”.
3)	 Open the Configs folder and copy the path.
4)	 Navigate to the folder where LightWave 11 is installed, and enter the bin folder.
5)	 Find the Layout.exe file.
6)	 Right-click and choose Create Shortcut
7)	 Right-click on the new shortcut and choose Properties
8)	 For Target, go to the end of the path and type -i -c
9)	 Paste the Configs path to the end of -c. If you have any spaces in the 

Config path, put the path in quotation marks. The path should look 
something like this (your exact path may be different):

C:\Program Files\NewTek\LightWave11.0\bin\Layout.exe -i -c”C:\Program Files\NewTek\
LightWave11.0\support\Configs”

10)	Repeat steps 5-9 for Modeler.exe
11)	Use the shortcuts you created each time you open the software.

Note for Windows Vista and Windows 7 Users
Vista’s virtual store redirects files away from the traditional C:\Program Files place where LightWave 
sits by default. LightWave does not recognize the Virtual Store so there are two things that can be 
done. One is to install LightWave in a non-traditional location, such as C:\NewTek\LightWavev11.0, 
the other is to temporarily turn off UAC. To do this, open your Control Panel and just type UAC. 

You don’t need to click anywhere to do it. This will open up a window asking if you want to 
leave your computer unprotected by turning off UAC, but you only need to do it for registering 
LightWave. This will require a reboot of the system. Alternatively, you can hit the Windows-r 
keyboard shortcut, type “msconfig” and go to the Tools tab in the window presented and select 
Disable UAC.

Then you can load Layout (with the blue icon), go to the Help menu and choose Enter License. 
Once you have pasted your license.key number in (16 digits, with hyphens between each four like 
so: 1234-5678-9012-3456) and restarted LightWave, you can turn UAC back on.
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Mac Universal Preferences and License Keys
The license.key file for a single user, and user-specific settings should go in:

~/Library/Application Support/NewTek/LightWave/11.0/licenses

Any license.key file you want all users to have access to, and machine-specific settings should go in:

/Library/Application Support/NewTek/LightWave/11.0/licenses

Third party plug-ins for the user (as they start showing up) should probably go in:

~/Library/Application Support/NewTek/LightWave/11.0/Plugins/

Third party plug-ins you want all users of your machine to have access to should go in:

/Library/Application Support/NewTek/LightWave/11.0/Plugins/

The Extensions configuration file used to contain a list of all of the plug-ins you’re using. Since we’re 
using an automatic search now, the Extensions file will be empty by default. If the user manually 
adds a plug-in via the Add Plugins command, or by any non-automatic means, it will show up in 
that file. We’re trying to move away from this mechanism, but we’ve left this capability in, in case 
you really need it.

Any objects or scenes you drag and drop into LightWave windows will not change the content 
directory.

Instructions for creating and placement of the license.key file in the Universal Binary:

1)	 Open TextEdit.app
2)	 Paste your permanent key on the first line
3)	 Select the ‘Make Plain Text’ item in the Format menu
4)	 Save the file. Name the file ‘license.key’, and place it in any one of the following folders:

SharedSupport folder, which is in the main LightWave program folder, next to Layout, Modeler, and 
other LightWave tools.

~/Library/Application Support/NewTek/LightWave/11.0/licenses

5)	 Open Layout to confirm that the key worked.
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Mac Universal Binary: Running Without the Hub
One of the important changes is to the communications between the applications. LightWave uses 
a module called the “Hub” to provide communications and data exchange between Layout and 
Modeler. A means for not running the Hub has always been an option for workflows where this 
exchange is not desired. To provide for a means of interoperation of Layout and Modeler with other 
applications, operations have been changed so that a new interprocess communications mode will 
be active when the Hub is not active. When this new interprocess communication is active, Layout 
and Modeler will each update an object that they both have loaded, and which has been changed 
and saved from one of the applications. Operation with no communications is now accommodated 
with a new “Isolate” Mode.

For full discussions of these new modes and features, please see the manuals or help files.

For your convenience, we provide information below about how to run without the Hub, how to 
run in Isolate mode, and how to redirect your config files for portability of your LightWave folder, if 
you will be running from an external drive and changing systems.

The easiest means to run without the Hub is to locate and rename the Hub executable file in the 
same folder containing the Layout and Modeler applications. Once renamed, Layout and Modeler 
will not be able to locate and use it.

Launching From a Script to Disable the Hub  or the Hub + IPC on the Mac
For users who would like to have something they can mouse-click on to launch Layout, Modeler, 
or another application with specific arguments passed to it, it is simple to create a “bash” script 
to accomplish this. In the examples below we will set up a script to run without the Hub, which 
engages the inter-process communication (IPC) that lets Layout and Modeler talk to one another 
and to other application that may support this new method, and a script to run the applications 
in Isolate mode, with both Hub and IPC off, so the applications do not communicate with one 
another.

In our example scripts we will run Layout with the proper arguments for running without the Hub, 
and for running in Isolate mode. The same approach can be used to launch Modeler and other 
applications, as well as to specify other arguments than we have shown in the examples.

Script for Running Layout without the Hub
1)	 Launch /Applications/TextEdit by double clicking its icon.
2)	 Enter the following text into the edit window. It is important to have 

the “.app” extension included in the filename. The location of your 
LightWave installation may differ, so adjust as needed.
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#!/bin/sh
open /Applications/NewTek/LightWave3D11.0/Layout.app --args -0

3)	 Save the text file to your desktop as “Launch Layout NoHub”. 
Make sure to avoid a “.txt” extension when saving.

4)	 Open a Terminal window using the /Applications/Utilities/Terminal application.
5)	 The script must be ‘executable’ so it will launch as a command when double-clicked 

with the mouse instead of opening as a text file. Make sure the current working path 
is the desktop (enter “cd ~/Desktop” if necessary) then enter this command.

chmod +x “Launch Layout NoHub”

Note that on some OS configurations, you may need to prefix the file name with ./;  and to 
avoid quotes, the spaces need a \ before them; so, either this:

chmod +x “./Launch Layout Isolated”

or this:

chmod +x ./Launch\ Layout\ Isolated

may need to be used instead.

6)	 Now, you can simply double-mouse-click the icon to launch Layout without the Hub.

Script for Running Layout in Isolate mode
1)	 Launch /Applications/TextEdit by double clicking its icon.
2)	 Enter the following text into the edit window. It is important to have 

the “.app” extension included in the filename. The location of your 
LightWave installation may differ, so adjust as needed.

#!/bin/sh
open /Applications/NewTek/LightWave3D11.0/Layout.app --args -i

3)	 Save the text file to your desktop as “Launch Layout Isolated”. 
Make sure to avoid a “.txt” extension when saving.

4)	 Open a Terminal window using the /Applications/Utilities/Terminal application.
5)	 The script must be ‘executable’ so it will launch as a command when double-clicked 

with the mouse instead of opening as a text file. Make sure the current working path 
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is the desktop (enter “cd ~/Desktop” if necessary) then enter this command.

chmod +x “Launch Layout Isolated”

Note that on some OS configurations, you may need to prefix the file name with ./; 
and to avoid quotes, the spaces need a \ before them; so, either this:

chmod +x “./Launch Layout Isolated”

or this:

chmod +x ./Launch\ Layout\ Isolated

may need to be used instead.

6)	 Now, you can simply double-mouse-click the icon to launch Layout in Isolate mode.

Mac Universal Binary: Redirecting Config Files
UB LightWave configuration files can be changed by placing the ‘redirected’ config files into a 
folder named “Preferences” in the same folder containing the Layout and Modeler applications.

This allows the config files to ‘follow’ the location of the UB applications, such as being placed onto 
a USB flash drive.

Alternatively, it is also possible to place config files into a “SharedSupport/Preferences” folder, 
which can be used to avoid cluttering the folder containing Layout and Modeler apps. The former 
folder supersedes the latter, and both supersede a user’s “~/Library/Application Support/NewTek/
LightWave/11.0” folder.

Mac Dongle Notes

Rainbow Eve3 Dongles: Exchange Needed for 64-bit Cocoa LightWave
LightWave 11.0 includes both 32-bit and 64-bit Mac support. If you are upgrading from a 9.x or 
earlier version of LightWave and have an Eve3 dongle, you need to be aware that only the Sentinel 
framework is provided for 64-bit operation, because SafeNet does not have plans to port the Eve3
Framework, which is required for the Mac-only Eve3 USB Dongles. If you plan to use the 64-bit 
version of LightWave 11, you will need to exchange it for the current Sentinel Ultrapro Dongle.

You can determine if you have an Eve3 dongle by checking the engraved logo on the top, where it 
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will say Rainbow/Eve3.

Folks who have an Eve3 dongle can call or email Customer Services to request that the 
replacement dongle be sent out. There will be at most a small charge for the dongle exchange, the 
replacement will ship immediately upon request, and the customer can return the Eve3 dongle 
that is being retired after receiving and getting set up and running with the new Ultrapro dongle 
and new dongle ID.

NewTek will also provide confirmation of the exchange to any third parties from whom the user 
has products that key to the dongle, as for example do Worley Labs products. If you round up 
the necessary fax numbers or email addresses for your third party products, you can provide that 
information in your first call or email to NewTek CS, and that will enable the CS staff to send out the 
confirmation notices very quickly after entering the order.

Please note that we are not able to provide an exchange unit with the same Lock ID number that 
you currently have. If you have third party plugins that are keyed to the dongle but are no longer 
supported, you will not be able to use those plugins with the new dongle.

Rainbow/SafeNet Duo Dongles: Notes for Use with 32-bit and 64-bit Cocoa 
LightWave
Originally, Rainbow was the company that made the dongles used by LightWave 3D. Rainbow was 
later acquired by SafeNet, so some Duo dongles are labeled Rainbow and some SafeNet. The Duo 
dongle information below applies to all Duos, regardless of which company name they show.

The Rainbow or SafeNet Duo dongle supports both the Eve3 Framework and the Sentinel driver. 
For LightWave 3D 11 64-bit the Sentinel Driver is used, and so will report a different Lock ID than 
did your 32-bit Mac LightWave 3D. Registration needs to be updated to allow for this, so for now 
users with Duo dongles will need to contact Customer Services in order to get a license key for 64-
bit Mac UB, as Registration is generating a key based on the Eve3 lock ID.

Please note, however, that if you have also registered the Windows Lock ID for your Duo Dongle, 
then Registration may have generated an Open Beta license key for that ID, and if so, that should 
work as well for 64-bit on Mac.

Note About Configuration Files

If you have been using a beta version of LightWave 11, please delete the configuration files related 
to those builds.

3rd Party License Notifications

All 3rd-party license notifications are located in the <installation>/docs/Licenses/ folder.
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